1. Silabus Kursus Komputer Dasar (MS Office, Pengantar Teknologi Komputer)
A. Silabus Kursus Komputer Dasar:
	Topik
	Deskripsi Materi
	Durasi

	1. Pengenalan Komputer
	- Definisi komputer
- Jenis-jenis komputer
- Komponen komputer (hardware & software)
	4 jam

	2. Sistem Operasi Windows
	- Pengenalan Windows OS
- Pengaturan dasar (start menu, taskbar, file explorer)
	4 jam

	3. Microsoft Word
	- Pengenalan MS Word
- Pengaturan dokumen, format teks, penggunaan tabel
	6 jam

	4. Microsoft Excel
	- Pengenalan MS Excel
- Fungsi dasar (SUM, AVERAGE, IF)
- Penggunaan grafik dan tabel
	6 jam

	5. Microsoft PowerPoint
	- Pengenalan MS PowerPoint
- Pembuatan slide presentasi dan animasi dasar
	6 jam

	6. Pengenalan Internet
	- Penggunaan browser (Google Chrome, Mozilla)
- Pencarian informasi, email, keamanan internet
	4 jam

	7. Penggunaan Jaringan
	- Pengenalan jaringan komputer
- Pengaturan koneksi internet dan jaringan lokal
	4 jam

	Total Durasi
	-
	34 jam



2. Silabus Kursus Digital Elektronika Dasar
	Topik
	Deskripsi Materi
	Durasi

	1. Pengenalan Komponen Elektronika
	- Resistor, kapasitor, transistor, dioda, IC
- Fungsi dan cara kerja dasar komponen
	4 jam

	2. Rangkaian Elektronika Dasar
	- Rangkaian seri dan paralel
- Pengukuran tegangan, arus, dan resistansi menggunakan multimeter
	6 jam

	3. Pengenalan Mikrokontroler (Arduino)
	- Pengenalan Arduino
- Pemrograman dasar Arduino dan penggunaan sensor sederhana
	8 jam

	4. Pembuatan Rangkaian Sederhana
	- Merakit rangkaian dengan komponen elektronika
- Membaca dan memahami datasheet komponen
	6 jam

	5. Pengendalian Motor & Sensor
	- Penggunaan motor DC, servo, dan sensor (suhu, cahaya, jarak) dengan mikrokontroler
	8 jam

	6. Penyelesaian Proyek Elektronika Sederhana
	- Proyek akhir pembuatan rangkaian elektronik (misalnya: lampu otomatis dengan sensor cahaya)
	8 jam

	Total Durasi
	-
	40 jam



3. Rencana Pelaksanaan Pembelajaran (RPP) untuk Kursus Komputer Dasar:
RPP untuk Modul Microsoft Word
	Komponen
	Deskripsi

	Identitas Mata Pelatihan
	Nama Pelatihan: Kursus Komputer Dasar
Modul: Microsoft Word

	Standar Kompetensi
	- Menguasai penggunaan MS Word untuk pembuatan dokumen teks.

	Kompetensi Dasar
	- Menggunakan MS Word untuk membuat, mengedit, dan menyimpan dokumen.

	Indikator
	- Membuat dokumen teks yang lengkap dengan penggunaan format teks.
- Menambahkan tabel dan gambar.

	Tujuan Pembelajaran
	- Peserta dapat membuat dokumen teks dengan format yang rapi dan tepat.

	Materi Pembelajaran
	- Pengenalan MS Word
- Membuat dokumen baru, pengaturan teks, paragraf, dan gambar.
- Penyimpanan dan format dokumen.

	Metode Pembelajaran
	- Ceramah, praktek langsung, diskusi kelompok.

	Media Pembelajaran
	- Komputer dengan Microsoft Word terinstal, proyektor, buku panduan.

	Langkah-langkah Pembelajaran
	1. Pendahuluan (10 menit): Menyampaikan tujuan dan manfaat MS Word.
2. Penyampaian Materi (20 menit): Mengajarkan dasar penggunaan MS Word.
3. Praktek (40 menit): Peserta mempraktikkan membuat dokumen teks.
4. Diskusi & Evaluasi (20 menit): Tanya jawab dan evaluasi hasil latihan.

	Penilaian
	- Penilaian dilakukan berdasarkan hasil praktek pembuatan dokumen.

	Waktu
	- 1 sesi = 90 menit





4. Modul Pelatihan Kursus Komputer Dasar:
Modul: Penggunaan Microsoft Word untuk Pemula
Tujuan: Peserta dapat menguasai dasar-dasar Microsoft Word, mulai dari pembuatan dokumen hingga penggunaan fitur format dasar.
Konten Modul:
· Bab 1: Pengenalan Microsoft Word
· Apa itu Microsoft Word?
· Fitur-fitur utama: Ribbon, Tab, Group, Command.
· Cara membuat dokumen baru.
· Bab 2: Mengatur Halaman dan Teks
· Menentukan ukuran kertas, margin, orientasi.
· Mengetik dan mengedit teks.
· Mengatur font, ukuran, warna teks, dan jenis font.
· Bab 3: Format Paragraf
· Menyusun dan memformat paragraf: rata kiri, kanan, tengah, justify.
· Pengenalan bullet points, numbering, dan indentasi.
· Bab 4: Menambahkan Tabel
· Cara membuat dan memformat tabel.
· Menambahkan dan menghapus kolom dan baris.
· Menggunakan alat desain tabel.
· Bab 5: Menambahkan Gambar
· Cara menambahkan gambar ke dalam dokumen.
· Mengatur posisi gambar dengan teks.
· Bab 6: Penyimpanan dan Penggunaan Template
· Menyimpan dokumen dalam berbagai format.
· Menggunakan template dokumen untuk pembuatan dokumen yang cepat.
· Bab 7: Proyek Akhir
· Tugas akhir: Membuat dokumen lengkap (surat, laporan, atau resume) menggunakan fitur-fitur yang telah diajarkan.



Modul: Pengenalan Arduino untuk Pemula
Tujuan: Peserta dapat memahami dasar-dasar mikrokontroler, serta dapat membuat rangkaian dan program sederhana menggunakan Arduino.
Konten Modul:
· Bab 1: Pengenalan Mikrokontroler
· Apa itu Arduino?
· Komponen yang dibutuhkan (Arduino board, kabel USB, LED, resistor).
· Instalasi perangkat lunak Arduino IDE.
· Bab 2: Membuat Program Pertama
· Penjelasan dasar sintaks Arduino (setup, loop).
· Menulis program untuk menyalakan dan mematikan LED.
· Bab 3: Penggunaan Sensor dan Aktuator
· Pengenalan sensor (sensor suhu, sensor cahaya).
· Membaca nilai sensor dan mengendalikan LED berdasarkan input sensor.
· Bab 4: Pengendalian Motor DC
· Menggunakan motor DC dan motor servo dengan Arduino.
· Program untuk menggerakkan motor berdasarkan input tombol.
· Bab 5: Proyek Akhir
· Proyek pembuatan rangkaian elektronika sederhana (misalnya: lampu otomatis yang menyala berdasarkan sensor cahaya).



5. Format dan Penjelasan Detail untuk RPP dan Modul
Modul dan RPP dapat dibuat lebih rinci dengan menambahkan berbagai aktivitas praktek, kuis, atau tugas yang berhubungan dengan materi yang diajarkan. Untuk kursus dengan materi yang lebih kompleks seperti digital elektronika, Anda bisa memperkenalkan konsep yang lebih mendalam tentang mikrokontroler, sensor, dan sistem kontrol yang lebih canggih di setiap modul.

Penutup:
· Silabus memberikan gambaran umum tentang apa yang akan dipelajari dalam kursus.
· RPP adalah rencana detail dari setiap sesi, memberikan pedoman bagi pengajar untuk mengelola kelas dengan lebih baik.
· Modul adalah bahan ajar yang mendalam dan dapat digunakan peserta untuk belajar lebih lanjut tentang topik tertentu.


Modul 1: Pengenalan Komputer dan Sistem Operasi Windows
Tujuan Modul:
Peserta dapat memahami dasar-dasar komputer, komponen perangkat keras dan perangkat lunak, serta cara menggunakan sistem operasi Windows.

1.1 Pengenalan Komputer
Definisi Komputer:
Komputer adalah perangkat elektronik yang digunakan untuk memproses data dan menghasilkan informasi. Komputer dapat melakukan berbagai tugas mulai dari perhitungan matematika, penyimpanan data, hingga komunikasi.
Komponen Utama Komputer:
1. Hardware: Komponen fisik komputer yang dapat dilihat dan disentuh.
· Contoh: CPU, Monitor, Keyboard, Mouse, Printer.
2. Software: Program yang memberi perintah kepada hardware.
· Contoh: Sistem Operasi (Windows, Linux), aplikasi (Microsoft Office, Browser).
Jenis-Jenis Komputer:
· Desktop: Komputer yang digunakan di meja kerja.
· Laptop: Komputer portabel.
· Tablet: Komputer dengan layar sentuh.
Gambar:
· Diagram blok komputer yang menunjukkan hubungan antara hardware dan software.

1.2 Sistem Operasi Windows
Apa itu Sistem Operasi?
Sistem operasi adalah perangkat lunak yang mengelola perangkat keras komputer dan menyediakan layanan untuk program-program aplikasi.
Pengenalan Windows:
· Antarmuka Pengguna: Taskbar, Start Menu, dan Desktop.
· Fungsi Dasar: Menjalankan aplikasi, mengelola file dan folder, mengatur pengaturan sistem.
Bagaimana Cara Menggunakan Windows?
1. Menyalakan Komputer: Tekan tombol power pada CPU atau laptop untuk memulai.
2. Start Menu: Tempat untuk mengakses aplikasi dan pengaturan sistem.
3. Taskbar: Menampilkan aplikasi yang sedang berjalan.
4. File Explorer: Untuk mengelola file dan folder di komputer.
Langkah-Langkah Mengakses File:
1. Klik Start Menu.
2. Pilih File Explorer.
3. Navigasikan ke folder yang diinginkan untuk membuka file.
Gambar:
· Gambar Start Menu, Taskbar, dan ikon File Explorer di Windows.



Modul 2: Microsoft Word – Dasar Penggunaan
Tujuan Modul:
Peserta dapat menggunakan Microsoft Word untuk membuat, mengedit, dan menyimpan dokumen.

2.1 Pengenalan Microsoft Word
Apa itu Microsoft Word?
Microsoft Word adalah aplikasi pengolah kata yang digunakan untuk membuat dokumen teks, laporan, surat, dan lain-lain.
Antarmuka Microsoft Word:
· Ribbon: Menyediakan berbagai fitur dan alat pengeditan.
· Menu File: Menyediakan opsi untuk membuka, menyimpan, dan mencetak dokumen.
· Dokumen Area: Tempat menulis teks.
Fungsi Utama di Microsoft Word:
· Membuat dan mengedit teks.
· Menyisipkan gambar, tabel, dan grafik.
· Memformat teks dan paragraf.
· Menggunakan template dokumen.
Langkah-langkah Membuat Dokumen:
1. Klik File > New untuk membuat dokumen baru.
2. Mulailah mengetik teks Anda.
3. Gunakan alat di Ribbon untuk mengubah font, ukuran, dan warna teks.
4. Untuk menyimpan dokumen, klik File > Save dan beri nama dokumen.
Gambar:
· Screenshot antarmuka Microsoft Word dengan penjelasan elemen-elemen utama (Ribbon, Menu, Dokument Area).

2.2 Memformat Teks dan Paragraf
Mengubah Ukuran dan Jenis Font:
· Pilih teks yang ingin diubah.
· Gunakan opsi Font di Ribbon untuk mengganti jenis dan ukuran font.
Mengatur Paragraf:
· Untuk meratakan teks ke kiri, kanan, tengah, atau justify, pilih opsi yang sesuai di bagian Paragraph.
· Anda juga bisa mengatur indentasi dan spasi antar paragraf.
Menambahkan Tabel:
1. Pilih tab Insert.
2. Klik Table dan pilih ukuran tabel.
3. Isi tabel dengan data atau teks.
Gambar:
· Screenshot langkah-langkah memformat teks dan menambahkan tabel di Word.



Modul 3: Microsoft Excel – Dasar Penggunaan
Tujuan Modul:
Peserta dapat menggunakan Microsoft Excel untuk membuat lembar kerja, menggunakan rumus dasar, dan menganalisis data.

3.1 Pengenalan Microsoft Excel
Apa itu Microsoft Excel?
Microsoft Excel adalah aplikasi pengolah data berbentuk spreadsheet yang digunakan untuk menghitung, menganalisis, dan menyajikan data dalam format tabel.
Antarmuka Excel:
· Ribbon: Menyediakan alat untuk pengolahan data.
· Worksheet: Tempat untuk memasukkan data.
· Formula Bar: Untuk mengetik rumus atau teks.
Fungsi Utama di Microsoft Excel:
· Menggunakan rumus (seperti SUM, AVERAGE, IF).
· Menyusun data dalam baris dan kolom.
· Membuat grafik dari data.
Langkah-langkah Membuat Lembar Kerja:
1. Masukkan data ke dalam sel.
2. Gunakan rumus untuk melakukan perhitungan.
3. Klik Insert untuk menambahkan grafik dari data.
Gambar:
· Screenshot antarmuka Excel dan penjelasan elemen-elemen utama (Ribbon, Worksheet, Formula Bar).

3.2 Menggunakan Rumus di Excel
Rumus Dasar:
· SUM: Menjumlahkan nilai dalam rentang sel.
· Contoh: =SUM(A1:A5)
· AVERAGE: Menghitung rata-rata nilai dalam rentang sel.
· Contoh: =AVERAGE(B1:B5)
· IF: Menghitung nilai berdasarkan kondisi tertentu.
· Contoh: =IF(A1>100, "Lulus", "Tidak Lulus")
Langkah-langkah Menggunakan Rumus:
1. Pilih sel tempat rumus akan diterapkan.
2. Ketik rumus pada Formula Bar.
3. Tekan Enter untuk melihat hasilnya.
Gambar:
· Screenshot penggunaan rumus SUM, AVERAGE, dan IF di Excel.



Modul 4: Penggunaan Internet dan Pencarian Informasi
Tujuan Modul:
Peserta dapat menggunakan browser untuk mencari informasi di internet dan mengelola email.

4.1 Pengenalan Internet dan Browser
Apa itu Internet?
Internet adalah jaringan global yang memungkinkan komputer dan perangkat lain saling terhubung untuk berbagi informasi.
Apa itu Browser?
Browser adalah aplikasi yang digunakan untuk mengakses situs web di internet.
· Contoh browser: Google Chrome, Mozilla Firefox, Microsoft Edge.
Langkah-langkah Mencari Informasi di Internet:
1. Buka browser.
2. Ketik kata kunci di Google Search Bar.
3. Klik hasil pencarian untuk membuka halaman yang relevan.
Gambar:
· Screenshot tampilan Google Chrome dengan kolom pencarian dan hasil pencarian.

4.2 Mengelola Email
Apa itu Email?
Email (surat elektronik) adalah cara untuk mengirim pesan secara digital melalui internet.
Langkah-langkah Mengirim Email:
1. Buka aplikasi email (misalnya Gmail).
2. Klik Compose untuk membuat email baru.
3. Isi To dengan alamat email penerima, Subject dengan judul email, dan tulis pesan di kolom Body.
4. Klik Send untuk mengirimkan email.
Gambar:
· Screenshot tampilan Gmail dengan formulir untuk mengirim email.

Penutupan:
Modul ini memberikan dasar-dasar penggunaan komputer yang sangat berguna untuk pekerjaan sehari-hari, baik untuk pekerjaan kantor, pendidikan, maupun keperluan pribadi.

Cara Menambahkan Gambar:
Untuk menambahkan gambar ke dalam dokumen Word:
1. Buka dokumen Word Anda.
2. Pilih tab Insert di Ribbon.
3. Klik Pictures dan pilih gambar dari komputer Anda.
4. Sesuaikan ukuran dan posisi gambar dengan menggunakan fitur Wrap Text agar gambar tidak mengganggu teks di sekitarnya.


Modul Pelatihan: Pengenalan Arduino untuk Pemula
Tujuan Modul:
Peserta dapat memahami dasar-dasar penggunaan mikrokontroler Arduino, menulis program sederhana, dan menghubungkan Arduino dengan berbagai komponen elektronik seperti sensor, motor, dan LED.

Modul 1: Pengenalan Arduino
1.1 Apa itu Arduino?
Arduino adalah platform perangkat keras open-source yang digunakan untuk membuat proyek-proyek elektronik. Arduino terdiri dari papan sirkuit mikrokontroler yang dapat diprogram untuk menjalankan berbagai tugas berdasarkan input yang diberikan.
1.2 Komponen Utama Arduino:
1. Papan Arduino (Arduino Board): Tempat di mana semua komponen terpasang.
· Contoh: Arduino Uno, Arduino Nano, Arduino Mega.
2. Mikrokontroler: Chip yang menjalankan program dan mengendalikan perangkat elektronik lainnya.
· Contoh: ATmega328P (pada Arduino Uno).
3. Port USB: Digunakan untuk menghubungkan Arduino ke komputer untuk pemrograman.
4. Pin Digital dan Analog: Digunakan untuk menghubungkan perangkat eksternal seperti sensor, motor, dan LED.
5. Pin Power: Untuk menyediakan daya ke papan Arduino dan komponen lainnya.
1.3 Apa yang Bisa Dilakukan dengan Arduino?
· Mengendalikan motor dan lampu.
· Membaca sensor seperti suhu, cahaya, dan jarak.
· Membuat sistem otomatisasi seperti lampu otomatis, alarm, dan pengatur suhu.



Modul 2: Instalasi Perangkat Lunak Arduino IDE
2.1 Apa itu Arduino IDE?
Arduino IDE (Integrated Development Environment) adalah perangkat lunak yang digunakan untuk menulis dan mengunggah program ke papan Arduino. IDE ini gratis dan tersedia untuk berbagai sistem operasi (Windows, macOS, dan Linux).
2.2 Langkah-Langkah Instalasi Arduino IDE:
1. Download Arduino IDE:
· Kunjungi situs resmi Arduino: https://www.arduino.cc/en/software
· Pilih versi untuk sistem operasi Anda (Windows, macOS, atau Linux).
2. Instal Arduino IDE:
· Setelah selesai mendownload, jalankan file instalasi dan ikuti petunjuk di layar.
3. Menghubungkan Arduino ke Komputer:
· Gunakan kabel USB untuk menghubungkan papan Arduino ke komputer.
· Arduino akan dikenali oleh IDE.
4. Pemilihan Papan dan Port:
· Buka Tools > Board dan pilih jenis papan Arduino yang Anda gunakan (misalnya, Arduino Uno).
· Buka Tools > Port dan pilih port yang sesuai dengan Arduino Anda.
2.3 Memverifikasi Instalasi:
· Buka File > Examples > 01.Basics > Blink.
· Klik Upload untuk mengunggah program "Blink" ke Arduino. Jika LED di papan Arduino berkedip, berarti instalasi berhasil.



Modul 3: Memahami Program Arduino
3.1 Struktur Program Arduino
Program Arduino umumnya terdiri dari dua bagian utama:
1. Setup(): Bagian ini dijalankan satu kali saat Arduino pertama kali dinyalakan atau reset. Biasanya digunakan untuk inisialisasi perangkat (misalnya, pin mode).
2. Loop(): Bagian ini dijalankan berulang kali selama Arduino beroperasi. Semua perintah yang ingin dijalankan terus-menerus diletakkan di dalam fungsi loop.
Contoh kode dasar:
cpp
Salin kode
void setup() {
  // Inisialisasi pin LED sebagai output
  pinMode(LED_BUILTIN, OUTPUT);
}

void loop() {
  // Menyalakan LED
  digitalWrite(LED_BUILTIN, HIGH);
  delay(1000); // Menunggu selama 1 detik (1000 ms)
  
  // Mematikan LED
  digitalWrite(LED_BUILTIN, LOW);
  delay(1000); // Menunggu selama 1 detik (1000 ms)
}
3.2 Penjelasan Kode:
· pinMode(LED_BUILTIN, OUTPUT): Menentukan bahwa pin LED pada papan Arduino (LED_BUILTIN) akan berfungsi sebagai output.
· digitalWrite(LED_BUILTIN, HIGH): Menyalakan LED.
· digitalWrite(LED_BUILTIN, LOW): Mematikan LED.
· delay(1000): Menunggu selama 1 detik.



Modul 4: Menghubungkan Komponen ke Arduino
4.1 Menghubungkan LED ke Arduino
Komponen yang Diperlukan:
· 1 x LED
· 1 x Resistor (220 ohm)
· Kabel penghubung
Langkah-Langkah:
1. Hubungkan LED ke Pin 13 Arduino:
· Anoda (kaki panjang) LED dihubungkan ke pin 13.
· Katoda (kaki pendek) LED dihubungkan ke resistor, kemudian resistor dihubungkan ke ground (GND) di Arduino.
2. Program untuk Menyalakan LED: Gunakan kode Blink yang telah dibahas sebelumnya untuk menyalakan dan mematikan LED.
Gambar:
· Diagram rangkaian sederhana untuk menghubungkan LED ke Arduino (dengan pin 13).



Modul 5: Membaca Sensor dengan Arduino
5.1 Menghubungkan Sensor LDR (Light Dependent Resistor)
Komponen yang Diperlukan:
· 1 x LDR (Light Dependent Resistor)
· 1 x Resistor (10 kOhm)
· Kabel penghubung
Langkah-Langkah:
1. Penghubungan LDR:
· Satu sisi LDR dihubungkan ke 5V di Arduino.
· Sisi lainnya dihubungkan ke A0 (Pin Analog 0) dan juga ke resistor 10kOhm yang kemudian dihubungkan ke GND.
2. Kode untuk Membaca Nilai LDR:
cpp
Salin kode
int ldrPin = A0;  // Pin analog tempat LDR dihubungkan
int ldrValue = 0;  // Variabel untuk menyimpan nilai pembacaan

void setup() {
  Serial.begin(9600);  // Mengaktifkan komunikasi serial
}

void loop() {
  ldrValue = analogRead(ldrPin);  // Membaca nilai dari LDR
  Serial.println(ldrValue);  // Menampilkan nilai di Serial Monitor
  delay(1000);  // Menunggu 1 detik
}
Penjelasan Kode:
· analogRead(ldrPin): Membaca nilai analog dari pin A0, yang akan bervariasi tergantung pada intensitas cahaya yang diterima oleh LDR.
· Serial.println(ldrValue): Menampilkan nilai pembacaan di Serial Monitor.
Gambar:
· Diagram rangkaian untuk menghubungkan LDR ke Arduino.



Modul 6: Mengendalikan Motor DC dengan Arduino
6.1 Menghubungkan Motor DC
Komponen yang Diperlukan:
· 1 x Motor DC
· 1 x Motor Driver (misalnya, L298N)
· 1 x Power Supply (untuk motor)
· Kabel penghubung
Langkah-Langkah:
1. Hubungkan Motor ke Motor Driver:
· Sambungkan pin OUT1 dan OUT2 pada motor driver ke terminal motor.
· Hubungkan pin IN1 dan IN2 pada motor driver ke pin digital Arduino (misalnya, pin 9 dan 10).
2. Kode untuk Mengendalikan Motor DC:
cpp
Salin kode
int motorPin1 = 9;
int motorPin2 = 10;

void setup() {
  pinMode(motorPin1, OUTPUT);
  pinMode(motorPin2, OUTPUT);
}

void loop() {
  digitalWrite(motorPin1, HIGH);  // Motor berputar searah
  digitalWrite(motorPin2, LOW);
  delay(2000);  // Menunggu selama 2 detik
  
  digitalWrite(motorPin1, LOW);   // Motor berhenti
  digitalWrite(motorPin2, LOW);
  delay(2000);  // Menunggu selama 2 detik
}
Penjelasan Kode:
· digitalWrite(motorPin1, HIGH): Motor berputar ke satu arah.
· digitalWrite(motorPin2, LOW): Motor berputar.
· delay(2000): Waktu motor berputar selama 2 detik.
Gambar:
· Diagram rangkaian untuk menghubungkan motor DC dengan motor driver L298N dan Arduino.



Modul 7: Proyek Akhir – Sistem Pendeteksi Cahaya
7.1 Deskripsi Proyek:
Proyek ini menggunakan LDR untuk mendeteksi cahaya dan menyalakan LED saat cahaya rendah. Proyek ini akan melibatkan pembacaan sensor dan mengendalikan output digital (LED) berdasarkan kondisi input.
7.2 Komponen:
· 1 x Arduino Uno
· 1 x LDR
· 1 x LED
· 1 x Resistor (220 Ohm)
· Kabel penghubung
7.3 Langkah-Langkah:
1. Ikuti langkah-langkah di Modul 4 untuk menghubungkan LED.
2. Ikuti langkah-langkah di Modul 5 untuk menghubungkan LDR.
3. Gabungkan kode dari kedua modul untuk menyalakan LED berdasarkan pembacaan dari LDR.

Penutupan:
Modul ini memberikan dasar-dasar penggunaan Arduino untuk membuat berbagai proyek elektronik sederhana. Peserta pelatihan dapat melanjutkan ke proyek yang lebih kompleks dengan memanfaatkan lebih banyak sensor, motor, dan perangkat lainnya yang dapat dihubungkan ke papan Arduino.
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	Pengenalan penggunaan mikrokontroler (Arduino), sensor, dan dasar-dasar elektronik praktis.
	Tim Pengajar Elektronika
	Rp6.500.000
	Belum Dimulai
	Fokus pada keterampilan praktis.

	
	Promosi Kursus & Pemasaran untuk UMKM
	Menawarkan pelatihan komputer dan elektronika untuk UMKM dan pengusaha kecil.
	Tim Pemasaran
	Rp3.000.000
	Belum Dimulai
	Program pelatihan untuk pengusaha kecil.

	Mei
	Pelatihan Rangkaian Digital & Analog
	Mengajarkan rangkaian dasar digital dan analog (IC, op-amp, sirkuit dasar).
	Tim Pengajar Elektronika
	Rp7.000.000
	Belum Dimulai
	Fokus pada pemahaman rangkaian.

	
	Kursus Digital Marketing & IT Support
	Pelatihan digital marketing dan support IT untuk profesional di bidang teknologi.
	Tim Pemasaran, IT
	Rp6.000.000
	Belum Dimulai
	Pelatihan untuk profesional IT.

	Juni
	Evaluasi Pelatihan dan Persiapan Kursus Lanjutan
	Menyusun evaluasi pelatihan, memperbaiki materi, dan merencanakan kursus lanjutan.
	Tim Evaluasi, Admin
	Rp2.000.000
	Belum Dimulai
	Rencana kursus semester berikutnya.

	
	Kursus Robotika Dasar
	Kursus dasar robotika, pengendalian motor, dan pembuatan robot dengan mikrokontroler.
	Tim Pengajar Elektronika
	Rp8.000.000
	Belum Dimulai
	Fokus pada robotika dan mikrokontroler.

	Jumlah
	Rp58.500.000
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	Semester 2: Juli – Desember 2025
	
	
	
	
	

	
	
	
	
	
	
	

	Bulan
	Kegiatan Utama
	Tujuan / Sasaran
	Tanggung Jawab
	Anggaran (IDR)
	Status
	Catatan

	Juli
	Kursus Pemrograman Lanjutan (Python, Java)
	Kursus pemrograman tingkat lanjut (misalnya, Java, Python untuk aplikasi web dan desktop).
	Tim Pengajar Komputer
	Rp6.500.000
	Belum Dimulai
	Fokus pada keterampilan lanjutan.

	
	Kursus IoT (Internet of Things)
	Pengenalan konsep dan penerapan IoT menggunakan perangkat seperti ESP32, sensor, dan aplikasi IoT.
	Tim Pengajar Elektronika
	Rp8.000.000
	Belum Dimulai
	Fokus pada perkembangan IoT.

	Agustus
	Kursus Pengembangan Aplikasi Web & Mobile
	Pelatihan tentang pengembangan aplikasi web (React, HTML, CSS) dan aplikasi mobile (Android, React Native).
	Tim Pengajar, IT
	Rp7.500.000
	Belum Dimulai
	Pelatihan untuk pengembangan aplikasi.

	
	Pelatihan Elektronika Tingkat Lanjut (PCB Design & Soldering)
	Mengajarkan desain PCB dan teknik soldering untuk membuat perangkat elektronik.
	Tim Pengajar Elektronika
	Rp6.000.000
	Belum Dimulai
	Fokus pada keterampilan praktis.

	September
	Pelatihan Sistem Jaringan & Keamanan Cyber
	Pelatihan instalasi jaringan komputer dan dasar-dasar keamanan siber.
	Tim Pengajar Komputer
	Rp7.500.000
	Belum Dimulai
	Fokus pada kebutuhan industri.

	
	Webinar Teknologi & Elektronika
	Menyelenggarakan webinar untuk mempromosikan kursus dan memberikan pengetahuan terkini.
	Tim Pemasaran
	Rp2.500.000
	Belum Dimulai
	Pemasaran melalui webinar online.

	Oktober
	Kursus Pengembangan Robotika Lanjutan
	Kursus lanjutan robotika untuk aplikasi industri dengan mikrokontroler, motor, dan sensor.
	Tim Pengajar Elektronika
	Rp7.500.000
	Belum Dimulai
	Fokus pada robotika industri.

	
	Evaluasi Kursus & Umpan Balik
	Menilai hasil pelatihan dan mengumpulkan umpan balik untuk perbaikan semester berikutnya.
	Tim Evaluasi, Admin
	Rp1.500.000
	Belum Dimulai
	Pengumpulan feedback peserta.

	November
	Penyusunan Program Kursus 2026
	Menyusun rencana kursus untuk tahun depan, menyesuaikan dengan perkembangan tren teknologi terbaru.
	Tim Pengajar, Manajer Program
	Rp4.500.000
	Belum Dimulai
	Penyusunan kursus tahun depan.

	
	Pemasaran Kursus untuk Tahun Depan
	Promosi program pelatihan untuk tahun depan dan membuka pendaftaran awal.
	Tim Pemasaran
	Rp3.000.000
	Belum Dimulai
	Fokus pada pemasaran awal tahun depan.

	Desember
	Evaluasi Tahunan & Penyusunan Laporan Kinerja
	Menyusun laporan tahunan untuk mengevaluasi pencapaian dan tantangan yang dihadapi sepanjang tahun.
	Semua Tim
	Rp2.000.000
	Belum Dimulai
	Laporan dan evaluasi tahunan.

	
	Persiapan Kursus Tahun Depan
	Persiapan untuk program pelatihan dan anggaran tahun depan.
	Tim Pengajar, Keuangan
	Rp4.000.000
	Belum Dimulai
	Perencanaan tahun depan.

	Jumlah
	Rp60.500.000
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